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Warning and Disclaimer

Techkor Instrumentation assumes no liability for damages, whether direct or
consequential, arising out of the use, or inability to use, this product.

This product is not designed to operate indefinitely. The user assumes full
responsibility for all maintenance and testing of the product necessary to ensure
proper operation. Any testing situation should have proper backup and
redundant systems in place to ensure the safety and quality of the information
generated.

The information contained in this literature is based on our experience to date
and is believed to be accurate and reliable. However, Techkor Instrumentation
assumes no responsibility for the use of such information. The information
contained herein is intended as a guide for use by persons having technical skill
and at their own discretion and risk.
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Introduction and Getting Started

Welcome to the Maintenance Watchdog™ A.5 wireless vibration monitoring
system. This manual will provide you with all of the information required to
understand, install, configure, and operate your system. The manual is broken
up into several sections. Section | covers the Initial System Configuration,
Section Il covers Maintenance Watchdog Desktop installation, Section IIl covers
Data Controller Configuration, Section IV covers migrating to more complex
environments, and Section V covers third party interfaces. If at any time during
the installation you require assistance, contact technical assistance at 717-939-
2300.
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Section I. Initial System Configuration

Stand-alone configuration is the simplest configuration and is recommended for
the initial installation. This enables the user to get the system up and running
without having to deal with any enterprise networking issues. Once the system is
operational it is a relatively straightforward procedure to migrate the system to an
enterprise network. MS Windows XP/7 computer with an Ethernet card and MS
Internet Explorer 7 (8), a Data Controller 7044000-1, a USB Access Point
7043000-1 with USB Cable 7016010-1, a CROSSOVER cable, a wireless sensor
7034000-1 are required for this configuration.

1.1. Data Controller and Wireless Access Point Installation

Connect the Wireless Access Point 7043000-1 to the Data Controller 7044000-1
using USB Cable 7016010-1. Using the Ethernet CROSSOVER cable, connect
the Data Controller 7044000-1 to the computer. Apply power to the Data
Controller and computer. Follow Appendix I.

1.2. Networking IP Configuration

The next step is to get the Data Controller 7044000-1 and the computer to talk to
each other. Unless otherwise requested all Data Controller's 7044000-1 have a
factory set IP address of 192.168.0.32.

NOTE: It is very important to remember your Data Controller’'s IP address. It is
recommended that the IP address be written in the Data Controller's comment
field.

The next step is to set the IP address and subnet mask on the computer to IP
address within 192.168.0.255 subnet (for example 192.168.0.73) so that it can
communicate with the Data Controller 7044000-1.

Set the computers IP address by selecting Start/Control Panel/Network
Connections and highlight Local Area Connection and right click and select
Properties to bring up the following screen.
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-L- Local Area Connection Properties

General | Authentication | Advanced

Connect using:
B8 IntelRt) PRO/100YE Metwork Corne

Thiz connection uzes the following items:

4=l 05 Packet Scheduler -
[l %= AEGIS Protocal [[EEE 802 1% »3.0.0.8
L |nternet Protocol [TCPAR)

v
£ >

Description

Tranzsmizsion Control Protocol/Internet Protocal. The default
wide area netwark protocol that provides communication
across diverse interconnected networks.

Show icon in natification area when connected
Matify me when thiz connection has limited or no connectivity

Ok ] [ Cancel

Highlight the Internet Protocol (TCP/IP) line and select the Properties button.
Select the “Use the following IP address:” button and enter in the IP address,
192.168.0.73, as shown below. After entering this IP address the Subnet mask
information should automatically appear. Click OK and continue.

Internet Protocol (TCP/IP) Properties @E|

General
You can get [P zettings assigned autornatically if vour network supparts

this capability. Qthernwise, you need to ask your netwaork. administrator for
the appropriate |P settings.

() Obtain an IP address automnatically
(®) Uge the following IP address:
1P address: 192 168 . 0 . 73

Subnet mazk: 2R 2RV 2RR . 0

Diefault gateway:

() Use the fallowing DMS server addiesses:
Freferred DNS server | .

Alternate DNS server:

[ Ok l[ Cancel ]

The computer should be ready to connect to the Data Controller at this time.
Start Internet Explorer and enter http://192.168.0.32 in the address field. Data

Controller startup page should appear.
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http://192.168.0.32/

« Techkor Maintenance Watchdog solution - Windows Internet Explorer

M=l
& - Ehin192.158.0.32/ (=[] [zooal I2E
File Edit Wiew Favorites Tools Help @
& W |§- Techkor Maintenance Watchdog sol... [__| f - B - ® - [FPage v & Tools »
Welcome to Techkor Maintenance Watchdog solution

T ECHKOR™

INSTRUMENTATION
ALMSIN 01ADANCED Crwetsion Technolcgy, ne

+ Configure Data Controller

+» Maintenance Watchdog WEB Interface
« Install Maintenance Watchdog Desktop Application

Usefull utilites and components

+ PUTTY: A Free Telnet/SSH Client
« MySQL GUI Tools

« MySQL Community Server

© 2010 Techkor® Instrumentation. All rights reserved.
Done

" Trusted sites N0 -

Select Tools->Internet Options from Internet Explorer main menu. Select Trusted
sites from Security tab and press button Sites.

Internet Options

GenerallSBCUl’itY |Privacy Contert | Connections | Programs || Advanced

Select a zane to view or change security settings.

¢ ¥ /'O

Internet Local intranet e =)

Restricked
sites

Trusted sites

. f This zone contains websites that you
&

trust not to damage vour computer or
wour files.

You have websites in this zone.

Security level For this zone

Custom
Custom settings.

- To change the settings, click Custam level,
- To use the recommended settings, click Default level,

[ Custom level, ., ][ Default level ]

[ Reset all zones to defaulk level ]
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Add http://192.168.0.32 in to the list by pressing button Add on Trusted sites
dialog. Note: Require server verification (https:) check box should be unchecked.

Trusted sites X
4 ‘fou can add and remave websikes from this zane. All websites in
./' this zone will use the zone's security settings.
Add this website ko the zone!
http:/{192,168.0,32 L ndd
wiebsites:
[IRequire server verification (https:) For all sites in this zone

Close Trusted sites and Internet Optons dialogs. Now you can use Data
Controller's WEB Interface to configure and to control Maintenance Watchdog
A.5 system.
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Section Il. Data Controller Configuration

2.1. Data Controller Configuration using WEB Interface

Open Data Controller startup page (http://192.168.0.32). Click link Configure
Data Controller to open WEB Interface Window.

Connect to 192.168.... [2|X

The server 192.165.0.32 at Password Required requires a
username and password,

Warning: This server is requesting that your username and
password be sent in an insecure manner {basic authentication
without a secure connection),

User name: |g admin w |

Passward: [sesssnss]

Remember my passward

Password Verification Dialog should appear. Enter User name admin and enter
password, provided in the Data Controller startup parameters list. Data Controller
setup page appears.

< Data Controller, s/n 2 setup - Windows Internet Explorer

o) - B hitp: /11921680 32/cibinfdec_setp.cal Il [cacge [
File Edit View Favorites Tools Help @
s dr |@Data Controller, s/n 2 setup |7‘ fr - B dh - [Page v ©F Tools »

Data Controller, s/n 2 setup

Network parameters Time parameters

Controller parameters Target data base
apply new [ adjust time asap [ Rebost []
sderass 192168032 Fri Nov 12 09:47:46 2010 Serisl 2 Host .

Prefix 24

Fri Nowv 12 14:47:46 2010 E=ze radic addr. [§ | Datzbzz=
EBroadcast 192.168.0.255

‘Ameﬂca;‘NewﬁYurk Vrl

SSH server Telnet Login
Gatevay 19216802517 Local ntpserver /W‘ WEB zerver FT® server et R
Hostnsme  |eBOX530 | Bublic ntpserver 1 |poolntporg | MySQL server NTP server
Domain [actpowercom Public ntpserver
PrimaryONS  |1921680251 | public n
Seconderyons| | Public ntpserver
Thrdovs || Fublic ntpserver 5
./ Trusted sites ®100% -
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2.1.1. Network parameters

Address - IP address of Data Controller

Prefix - network mask, number of 1-bites from the left
Broadcast - broadcast address for subnet

Gateway - gateway IP

Hostname - Data Controller host name

Domain - domain name, if exists and is used

Primary DNS - primary domain names server IP address, if exists
Secondary DNS - secondary domain names server IP address, if exists
Third DNS - third domain names server IP address, if exists

Button Submit applies changes to the Data Controller's Network parameters.
Checkbox Apply now forces changes to take effect immediately.

Note: if you change IP address and Checkbox Apply now is on, old address still
is in effect until Data Controller reboot. To check new address will be in effect
already before reboot. In other words, both IP will be in effect before Data
Controller reboot.

2.1.2. Time parameters

Local time - displays current Data Controller’s local time
Universal time - displays current universal time

Time zone - defines Data Controller’'s Time Zone

Local ntpserver - IP of local ntp server, if exists

Public ntpserver 1 - network name of 1 public ntp server, if used
Public ntpserver 2 - network name of 2 public ntp server, if used
Public ntpserver 3 - network name of 3 public ntp server, if used
Public ntpserver 4 - network name of 4 public ntp server, if used
Public ntpserver 5 - network name of 5 public ntp server, if used

Button Submit applies changes to the Data Controller’s Time parameters.
Checkbox Apply now forces time adjustment immediately.

Note: specifying names of NTP servers assumes DNS system working.

2.1.3. Controller parameters

Serial - Data Controller Serial number
Base radio address - Data Controller radio address base
SSH server - starts sshd daemon on startup
Telnet - turns on telnet service on startup
WEB server - starts WEB on startup
FTP server - turns on FTP service on startup
NTP server - starts ntpd daemon on startup
TECHKODR™ Maintenance Watchdog™ A.5 Startup Manual 10
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MySQL server - starts mysqld on startup

Button Submit applies changes to the Data Controller's Network parameters.
Checkbox Reboot initiates Data Controller reboot.

Note: if you stop WEB server and reboot, you lose abilities to use WEB interface
and to reconfigure Data Controller through WEB interface. It is recommended to
turn off any of the system services only if you are sure of what you are doing.

2.1.4. Target data base

Host - IP address (or name) of Target Database Host

Database - Database name

Login - User ID, used by Data Controller to post data in to the database
Password - password, used by Data Controller to post data in to the database

Target data base parameters specify database location and credentials for Data
Controller scripts. Empty Host field is equivalent of localhost. It means Data
Controller’'s local database is used.

Note: 7044000-1 Data Controller holds 5 databases, named as mw_ab,
mw_a5 0, mw_a5 1, mw_a5 2, mw_a5 3, mw_a5_ 4. Credentials for all of them
are identical and are:

Login: mw_admin

Password: as specified in the Data Controller startup parameters list.

Default database name is mw_ab.

2.2. Data Controller Configuration using keyboard and monitor

Connect keyboard and monitor to the Data Controller. On login prompt enter
login id admin and press Enter. On password prompt, enter password as
specified in the Data Controller startup parameters list and press Enter.

Main rootfs for eBOX530-820-FL
Kernel 2.6.25-P486U-LH on an 1686

Password:

eB0R530 loiin: admin

On successful login status screen appears. Enter setup on command prompt.

TECHKOR™ Maintenance Watchdog™ A.5 Startup Manual 11



{(min +4.51 VY, max

{min +£.51 ¥, max

{(min +0.61 Y, max

{high -1.0 C, hyst = sensor = diode

{high = +126.9 C, hyst = +115.8 C) sensor = thermistor

beep_enable:enabled

RPC Software
PID ELAPSED COMMAND
186 . . 4404 fusr/local/mysql/libexec/mysqld ——-basedir=
807 . . 44:03 /bin/bash fusr/mw_ab/scripts/usb_rpc_watch
817 . . 44:03 /bin/bash fusr/mw_ab/scripts/auto_online
360 . . 44:03 fusr/mw_ab/rpc_ad_usb -a 13 -u 1l
Size Used Avail Use¥% Hounted on
26 1.16 616 2% /
File descriptors
free max
0 1062036
total used shared buffers cached
: 1827020 11140 ] 8220 26212
-/+ buffers/cache: 36648
Swap: 4] 0
Ne twork
IP 192.168.0.32
-bash-3.2% setu

Main configuration dialog appears:

Data controller s/n 2 configuration.

Data controller s/n 2 setup
Select option from menu:

time Time parameters
controller Data controller parmeters
target Target data base login parameters

< K > <Cancel> < Help >

You can select network parameters configuration, time parameters configuration,
controller parameters configuration and target data base parameters
configuration from this dialog. Use arrows keys to navigate between parameters.
Use <Tab> key to navigate to < Ok >, <Cancel> or <Help> items.

TECHKODR™ Maintenance Watchdog™ A.5 Startup Manual 12



2.2.1. Network parameters

Data controller s/n 2 configuration.

Data controller s/n 2 network setup
Select options from menu:

Network interface eth® parameters
DNS DNS parameters
Hostname Data controller hostname

< (K >l <Cancel> < Help >

You can select network interface ethO parameters configuration, DNS
configuration or Data Controller Hostname editing.

2.2.1.1. Network interface ethO parameters

Data controller s/n 2 configuration.

Data controller s/n 2 ethB@ setup
Enter or edit eth® parameters

Gateway: 1RESNIHET R
Broadcas tikran Ll s

<Cancel> < Help >

TECHKOR™ Maintenance Watchdog™ A.5 Startup Manual 13



Where:

IP - IP address of Data Controller

Prefix - network mask, number of 1-bites from the left
Gateway - gateway IP

Broadcast - broadcast address for subnet

Pressing Enter key on <Ok> item saves edited parameters. Pressing Enter key
on <Cancel> leaves dialog without saving parameters.

2.2.1.2. DNS parameters

Data controller s/n 2 configuration.

Data controller s/n 2 DHS setup
Enter or edit DNS parameters

Domain: Fictpower . com
Primary DNS: 1RRESEail il
Secondary DNS:

Third DHS:

< 0k > <Cancel> < Help >

Where:

Domain - domain name, if exists and is used

Primary DNS - primary domain names server IP address, if exists
Secondary DNS - secondary domain names server IP address, if exists
Third DNS - third domain names server IP address, if exists

Pressing Enter key on <Ok> item saves edited parameters. Pressing Enter key
on <Cancel> leaves dialog without saving parameters.

TECHKOR™ Maintenance Watchdog™ A.5 Startup Manual 14



2.2.1.3. Hosthame

Data controller s/n 2 configuration.

Data controller s/n 2 hostname setup
Enter or edit hostname

{eBUH53@

{Cancel> < Help >

Hostname - Data Controller host name

Pressing Enter key on <Ok> item saves edited hostname. Pressing Enter key on
<Cancel> leaves dialog without saving.

2.2.2. Time parameters

Data controller s/n 2 configuration.

Data Controller C2 time parameters setup
Choose setup options from menu:

Link localtime to zoneinfo file

local Sets local ntpserver
public Sets public nipserver

< UK > <Cancel> < Help >

You can select timezone, local and public ntp servers setups.
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2.2.2.1. Timezone

Please choose a zoneinfo file
Directories Files

Martinique
.. Mazatlan
Argentina Mendoza
Indiana Menominee
Kentuck Merida
North Dakota Mexico_City
Miquelon
Moncton
Honterrey
Montevideo
Montreal
Montserrat

Nassau
New York

fusr/share/zoneinfo/America/New York

<Cancel> < Help >

Use <Space> to select directory or file.
2.2.2.2. Local NTP server

Data controller s/n 2 configuration.

Data controller s/n 2 local ntp server setup
Enter or edit local ntp IP address

{192.168.@.2@@

<Cancel> < Help >

Enter or edit local NTP server IP. Local means NTP server within your network.

TECHKOR™ Maintenance Watchdog™ A.5 Startup Manual 16



2.2.2.3. Public NTP servers

Data controller s/n 2 configuration.

Data controller s/n 2 Public nitp servers setup
Enter or edit Public ntp servers parameters

server pool .ntp.org
server
server
server
server

< k> <Cancel> < Help >

Use this dialog to specify up to 5 public NTP servers.
Note: specifying names of servers assumes DNS system working.

2.2.3. Data Controller parameters

Data controller s/n 2 configuration.

Data controller s/n 2 parameters setup
Select options from menu:

serial Serial number

radio Base radio address
services System services on startup

< (K >l <Cancel> < Help >

You can select Data Controller serial number setup, base radio address setup
and data controllers services to start on startup.

TECHKOR™ Maintenance Watchdog™ A.5 Startup Manual 17
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2.2.3.1. Serial number

Data controller s/n 2 configuration.

Data controller s/n 2 serial number setup
Enter or edit serial

2

{Cancel> < Help >

You can edit serial number of Data Controller.

3.2.3.2. Base radio address

Data controller s/n 2 configuration.

Data controller s/n 2 radio address setup
Enter or edit radio address

8

<Cancel> < Help >

You can edit base radio address of Data Controller.

TECHKOR™ Maintenance Watchdog™ A.5 Startup Manual 18



2.2.3.3. System services on startup

#192.168.0.32 - PuTTY

Data controller s/n 2 configuration.

Data controller s/n 2 System services setup 7
Choose Data Controller’s Services to run on startup

[ = 1| WY server
[=] ftpd FTP server
=] telnet Telnet

=] sshd SSH server

mysold MySQL server
ntpd NTP server

[
[
[
[

< Uk > <Cancel> < Help >

WEB server - starts WEB server daemon on startup
FTP server - turns on FTP service on startup
Telnet - turns on telnet service on startup
SSH server - starts sshd daemon on startup
MySQL server - starts mysqld on startup

NTP server - starts ntpd daemon on startup

Note: if you stop WEB server and reboot, you lose abilities to use WEB interface
and to reconfigure Data Controller through WEB interface. It is recommended to
turn off any of the system services only if you are sure of what you are doing.
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2.2.4. Target data base parameters

Data controller s/n 2 configuration.

Target database configuration
Target database configuration

Host

Database mw_ao
User ID mw_admin
Password 3 3 30 ¢ ¢

< [k > <Cancel> < Help >

Host - IP address (or name) of Target Database Host

Database - Database name

Login - User ID, used by Data Controller to post data in to the database
Password - password, used by Data Controller to post data in to the database

Target data base parameters specify database location and credentials for Data
Controller scripts. Empty Host field is equivalent of localhost. It means Data
Controller’s local database is used.

Note: 7044000-1 Data Controller holds 5 databases, named as mw_ab,
mw_a5 0, mw_a5 1, mw_a5 2, mw_a5 3, mw_a5 4. Credentials for all of them
are identical and are:

Login: admin

Password: as specified in the Data Controller startup parameters list.

Default database name is mw_ab5.
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Section Ill. Maintenance Watchdog Desktop Application

3.1. Maintenance Watchdog Desktop Application Installation

Open Data Controller startup page (http://192.168.0.32). Click link Install
Maintenance Watchdog Desktop Application to install Window application.

File Download - Security Warni...g\
Do you want to run or save this file?

A Mame: MwiSetup.msi
e
=T Type: windows Installer Package, 1,.91ME

From: 182.168.0,32

Bun | [ sawe | [ Cameel |

{3 Wi flesfom the ntemet can be Lsefl. tis e s con
! ﬂ A I T o i (1 v g Fe, o s
"7 o save this software, What's the risk?

Click Run on File Download security warning and on Internet Explorer security
warning.

Internet Explorer - Security Warning §|

The publisher could not be verified. Are you sure you want to run this
software?

Name: MWSstup.msi

Fublisher: Unknown Publisher

This file does nat have a valid digtal signature that verifies its publisher, You
should anly run software from publishers you trust., How can 1 decide what
software o run?

Follow all steps of Installation Wizard by pressing button Next.

## Maintenance Watchdog (Rev. A.5) A= 4

Welcome to the Maintenance Watchdog [Rev. A.5]
Setup Wizard

The installer will guide you through the steps required to install Maintenance
Watchdog (Rev. A5) Client Application on your computer.

WARNING: This computer program is protected by copyright law and
international treaties. Unautherized duplication or distribution of this program, or
any portion of it, may result in severe civil or criminal penalties, and will be
prosecuted to the maximum extent possible under the law.
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3.2. Starting Maintenance Watchdog Desktop Application

You can launch Desktop application from Start menu:
Maintenance Watchdog (Rev. A.5)->Maintenance Watchdog Desktop.
Enter login parameters in the Database Login dialog.

Database Login

Server 192.168.0.32 |
Diatabase Imw_s5 |
IUger 1 ‘mw_admin |
Password ‘******* |
Remember Login l Ok ] [ Cancel
Where:

Server: Data Controller IP (192.168.0.32)

Database: Default Database name (mw_ab)

User ID: Default MW Administrator user name (mw_admin)

Password: provided in the Data Controller startup parameters list

Main window of Maintenance Watchdog Desktop:

= Maintenance Watchdog Desktop - admin@192.168.0.32/mw_a5

File Database View Tools Help
- )
Hierarchy |Equipment |

| Data List | Alarms |

= Factory 1 Data for Factory 1

hd

View |\fe\ocitv data "| History &l
Sender | Data Taken T(C)  Refer(y) WO WSM WM

0 records of O

F1 initiate Help.
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3.3. Verifying Equipment

Go to the Equipment tab In the Desktop application. Under hierarchy level
Database should be seeing Access Points and Data Controllers grouping levels.
Each of those levels should contain appropriate devices. Serial numbers should
reflect actual devices serial numbers. Serial number of device could be verified
under Overview tab from the right side of hierarchy.

= Maintenance Watchdog Desktop - admin®192.168.0.32/mw_a5
Eile Database Wiew Tools Help

Hierarchy | Equipment

By conmection O Cwverview |Status | Configure
Wireless Access Point N1 (N1) overview

= Database
3 Wireless Access Points

O DL N Systern Information

T O Data Canfrollers Received=Tue Nov § 12:28:43 2010 S
ToczE Cievice=USB Wireless Access Point

Serial =1|

Model=7043

Hardware Rev=A.0 o

0 records of O

3.4. Adding Accelerometers to the System

We have finally reached the point were we can watch the sensors log in. Before
beginning, verify the following:

e All sensors to be operated are within range of the access point
Wireless Access Point is connected to the Data Controller
Data Controller is connected to the computer
Desktop application is running on the computer and refresh (F5) works
Take one sensor and manually reset the sensor and then plug in the
battery.

3.5. Refresh Devices

Go to the Equipment tab on the Desktop application. Refresh the content of
Equipment by hitting “F5” (Database Refresh menu item hot key). Each sensor
that has been powered up should appear in the Equipment hierarchy as shown
below.

It is recommended to start and configure one sensor at a time.

For a two-sensor system the Equipment tab would look like the following. It may
take up to two minutes for the sensors to log in.
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= Maintenance Watchdog Desktop - admin@192.168.0.32/mw_a5 - OX
Eile Datsbase Wiew Tools Help

- )

Hierarchy Equipment‘
By connection O Overview |Status | Configure
&5 Database Accelerometar A447 (A447) overview
2 Wireless Access Points
@ ML (N Systern Information
1 © Data Confrollers Recalved=Tue Nov O 14:28:44 2010 ~
0 ©cz(c2) Device=Accelerameter
= Accelerometers Serial =447
= A44T (A447 Manufactured=Wed May 12 13:55:14 2010
= A326 (A326) Model=7034

Hardware Rev=A.0

Software Rev=A.5

Calibrated=Wed May 12 13:55:14 2010

Calibril=Factory =

| %

O records of O

Newly added sensor will connect to access point every 30 seconds until it is
reconfigured and scheduled. Now you can bind sensors to the Hierarchy location
points and schedule-configure them. Go to the Hierarchy tab and create (or
select) Point within hierarchy. Create or select Datalink under Configure tab. Bind
Vibration source (newly added accelerometer), select schedule Every min and
apply changes to the database. You should see data every minute under Data
List tab.

= Maintenance Watchdog Desktop - mw_admin@192.168.0.33/mw_a5

Eile [Datebase Wiew Tools Help
i

Hierarchy | Equipment:

Overview | Data List| Configure |Alarms

A 3 Factory 1 Datalink
A & Machine 1 Name Data Lirk 1 \
A 5 Location 1
A = Point 1-Datalink 1 | Vibration source | eNeRERE B

A = Point 2 - Data Link Z
A = Six Chanrel - Data li | Sampling [start Lp -
A

= Single Channel - Dat

Processing Processing 1 v
Alarm set ‘A\arms 1 .,‘
Schedule Every min v
Speedsorce | T57 v

[ Request data ASAP

Comments

|~
|~

See Maintenance Watchdog A.5 Desktop help for detalils.
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Section IV. Migrating to more complex environments

4.1. Expanding Maintenance Watchdog

The Maintenance Watchdog system can be expanded to handle larger and more
complex configurations by one of the following actions.

Adding Wireless Access Points: A cellular grid of coverage can be obtained by
adding wireless access points. Up to 4 wireless access points 7043000-1 can be
connected to the Data Controller 7044000-1 to provide overlapping coverage for
wireless accelerometers. More than one data controller can be used in the
system.

Adding Wireless Repeaters: The Wireless Access Point 7043000-1 can be used
as Wireless Active Repeater, when it is battery powered or DC powered. USB
interface can be used to power 7043000-1 device from DC USB power supply.

Adding Accelerometers: The Maintenance Watchdog system can handle
hundreds of sensors. Buy adding sensors to the already existing wireless sensor
network, the Maintenance Watchdog system can be expanded to cover a large
number of machines.

Adding Laser Tachometers: Laser tachometer can be added to a system to
gather running speed of machines. A single tachometer can be bound to more
than one data point and the system will automatically request a running speed
whenever data is scheduled.

Adding Client Data Controllers: The network data controllers can be operated
directly on an enterprise network, by properly configuring the IP settings. Client
data controllers deliver data to the master data controller, which holds data base

The following sections detail these expansions.

4.1.1. Adding additional Wireless Access Points

Up to four 7043000-1 USB Wireless Access Points (WAP) can be connected to
the 7044000-1 Data Controller. Up to 64 7043000-1 WAP units (including
7043000-1 WAP units in Repeater Mode) can be used within common radio
zone. Any newly added WAP has static radio address within range 1-64. Static
radio address is calculated as A=BA+PN*8+1, where BA is Data Controller's
base radio address, PN — USB port number (1-4).

Note: Techkor Wireless protocol is described in the document Protocol A.5
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4.1.2. Adding Wireless Repeaters

7043000-1 USB Wireless Access Point (WAP) can be added in to the system as
Active Repeater. It can be battery powered or USB power supply can be used.
Up to 7 Active Repeaters can be connected to the one 7043000-1 USB Wireless
Access Point.

Note: for A4 customers it is possible to upgrade A4 repeater to A5 firmware.

4.1.3. Adding Accelerometers

Any additional Accelerometer can be included in to the system as described in
3.4.

4.1.4. Adding Laser Tachometers

7033000-1 Laser Tachometer can be included in to the system similarly as
Accelerometer. Tachometer should be bound to the Data Link with existing
vibration source (accelerometer).

4.1.5. Adding Client Data Controllers

Additional 7044000-1 Data Controller can be added in to the system as Client
Data Controllers. Target Database Parameters should be set to direct data flow
to the master Data Controller. Base Radio Address should be set accordingly
4.1.1.

4.2. Use Windows Computer for Database

MySQL Database Engine is developed for very wide range of common
operational systems, including Microsoft Windows. There is no problem to
transfer Maintenance Watchdog A5 database to the Windows computer. Techkor
Instrumentation does not provide free customer support for such configurations.

4.3. Maintenance Watchdog A.5 WEB Interface

Maintenance Watchdog Web Interface provides capability to control Vibration
Data over http protocol. Internet Explorer 7 or higher should be used for this.
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4.3.1. Connecting Maintenance Watchdog A.5 WEB Interface

Open Data Controller startup page (http://192.168.0.32). Click link Maintenance
Watchdog WEB Interface to open WEB Interface Window.

Connect to watchdo... \EE\

The server watchdog. vibrametrix, com at Password Required
requires a username and password,

Warning: This server is requesting that your username and

password be sent in an insecure manner {basic authentication
without a secure connection),

User name:

| ﬂ v _admin hd |

Password: | LTTIIIT T |

Remember my password

[ 0K H Cancel ]

Password Verification Dialog should appear. Enter User name mw_admin and
enter password, provided in the Data Controller startup parameters list.
Maintenance Watchdog WEB Interface main page appears.

~ Maintenance Watchdog WEB Interface - Windows Internet Explorer

G- | B /7192.168.0.33/ogibingindex cgi
File Edit View Favorites Tooks Help

W | DMaintenance Wahthdog WEB Interface

Maintenance Watchdog WEB Interface

[Hide urbsund Data List  Configure  Alarms
Trend of | Valeoty RMS

8.00
© Devices - 7
D Alarn ts - 5.0
© Samplng parameters - 12 4.0
O Processing parameters - 3

& Transfer parameters - 3 1
& Schedules - 21 8

HA00% -

Note: Data Controller IP must be included in to the trusted sites list (https should
be off).
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Section V. Third party interfaces

5.1 Introduction

Maintenance Watchdog software allows users to export the data in a text file that
can be easily imported into a spreadsheet or other analysis tools.

5.2. Maintenance Watchdog Desktop Text Export
By right clicking on data listing and selecting Export from the menu the following

menu pops up. It is from this screen that a user configures what to export and
where to send the data.

Text Export 2 \@

9]

Seffinas
Export type name ‘Text Export V| [ Add I
Export file name ‘ | [ Select l
Objects to export
Type Acceleration Welocity Displacement
ol o o
Tirme Waveform O o
s o
Status Refarence Temperature
volts v ‘ ‘C W ‘

Select Export file name and press OK. All selected data records will be
exported into single file under Export file name.

Export can be initiated from Data View Form by selecting File->Export menu
item.

< Datalink FIM1L1P1 data 12/2/2010 2:11:00 PM

[Elle Miew  Opticrs
1 Open Mocation 1/Point 1, taken ab 12/2/2010 2: 1 1:00 BM by Add7,
Save As 0 2:11:01 PM, datalick FIMIL1PL, data processing Processing 1
\ Export ‘eloclhy Time Wavetorm: ~
Brinit M =2559.9255 cpm HMS=1.4124 ips, Peak=8.2014 ips, P1P= 3
= 19 1NGR Ime FF—& NST?
Print Prawlaw - e
ps
Close H €0
P R S s vt SN SO SO SO 0.0 e
0.70 | i i .40 i i | i
0 a0 [|.1...1.. Nl.l i ( {
0.50 SN N S S S S 0 _\nﬂ.:!l..li\,,..,._,q!‘ FER |‘|,\.\.\A| ﬁ!\\h_\,.]_ ||_IL.'
[ f
. 00 LD L | LA | S |
030 040 Y
0.20 0.50
010 -0.80
0.00 ; 100
= tpm sx
0.00 L00 200 3.00 400 500 600 7.00 0.00 010 020 0.30 040 050 060 0.70
Spectrum lires: 1024 - Sample count 2045 of 2253
Myguist freg.: F7098.9 com Sample rate: 153540 cpm
Parsoval's 54550 100 Real sample rate: 154197 9 cpm
Windowing: Harning Filter passbend; 2313.0.,.816/9. 2om
Dretection: Pk -
i H ™
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Appendix I. Antenna Considerations

The antennae of the Wireless Access Point 7043000-1 should be mounted in a
vertical orientation for optimal performance of the system.

The radio waves radiate perpendicular to the antennae as shown below. With
the antenna mounted vertically, the radio waves will travel parallel to the earth.

The Wireless Access Point 7043000-1 should be mounted at least 18" away from
walls, poles, or other objects that can detune the antenna.

Do not place Wireless Access Point 7043000-1 on or near devices that produce
large amounts of electromagnetic noise, such as a high voltage control panel or
conduit.
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Appendix Il. Installing a Wireless Accelerometer

The wireless accelerometers can be mounted in a variety of ways. It is strongly
recommended that the new users familiarize themselves with powering up,
configuring, and operating these sensors before they are permanently mounted
on equipment. Improperly configured sensors will require resetting, which will
require physical handling of the unit.

Mounting

Sensors can be mounted with the %-28 thread on the base of the unit. A spot
face tool or epoxied mounting pad should be used to provide a flat surface for the
sensor base to rest on. Recommended tightening torque is 24 in-lbs.
Threadlocking compounds (Loctite) may be used for a more secure mounting.
Alternatively, sensors can be mounted with adhesives or magnetic bases.

Powering Up and/or Resetting the Accelerometer
Sensors should be reset every time the battery
is replaced, or if the battery connector is
unmated. To reset the sensor:
= Disconnect the battery
= Short the pins of the battery connector
on the circuit board with screwdriver or
ballpoint pen
= Reconnect the battery

A sensor that has been powered up and not
configured in the Windows Desktop software
will begin to request to be configured
automatically over the wireless network. This
sensor must be configured within 60 minutes or it will go into a 24-hour safety
sleep mode. In 24 hours it will wake up and once again begin to request to be
configured for 60 minutes before going into a 24-hour safety sleep mode if it is
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still not configured. If it is desired to wakeup the sensor during this safety sleep
mode, it needs to be reset as described above.

Sealing the accelerometer

If the sensor is to be used in environments where moisture is a problem and a
NEMAA4 or IP65 rating is required, the accelerometer must be sealed according
to the following procedure:

Reset the sensor

Connect the battery

Wrap PTFE (Teflon) tape around the threads 3-6 times
Screw down the lid for a snug fit

Install the sensor

Configure within 60 minutes

TECHKDR™ Maintenance Watchdog™ A.5 Startup Manual 31

; e
L INSTRUMENTATION




Appendix lll, Battery Life

One of the most Iimportant questions F
concerning wireless sensors is: How long will |
the batteries last? It is difficult to provide an
easy answer because the battery life depends
upon how much the battery is used and its
environment. Because the Maintenance
Watchdog™ system allows the user a great
deal of flexibility, the battery life answer
becomes even more difficult to evaluate. It is
important to understand the factors that affect
the battery life and to configure the system to optimize the battery I|fe of the
monitoring system.

Factors that affect battery life:

e Polling mode — When polling mode is turned on, wireless sensor wakes
up every 3 seconds for short time (about 20 ms). During this time receiver
listens to radio band and checks for incoming packets. Turning polling off
significantly increases battery life.

e Frequency of Records — The criticality of an asset and the time to failure
should be considered when scheduling a wireless sensor. The least
amount of data records that will provide a high level of surveillance should
be selected. After the sensor is installed, the cost of monitoring is the $15
for a replacement battery and the cost to physically replace the battery.

e Length of Record — The minimum sampling resolution required to detect
possible faults should be selected so that the wireless transfer of data is
minimized. A longer data record uses more battery capacity. The
following are data record transport times under ideal conditions (data rate
3500bps):

0 2048 samples (800-line FFT)
0 4096 samples (1600-line FFT) 20 seconds
0 8192 samples (3200-line FFT) = 40 seconds

e Weak Radio Link — When a sensor does not receive a handshake from
the Network Access Point, it relies on packet retries to transfer data. A
sensor with a weak radio link might be able to transfer data successfully,
but it will use many retries to complete the message. The radio transfer
for each data record is timed and recorded to provide an indication of the
quality of radio link. With a weak radio link, a repeater might have to be
added to optimize the radio network.

10 seconds
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Repeater Usage — Using a repeater roughly doubles the time a wireless
sensor is transferring data, which cuts the battery life in half. The sensor
is awake longer because the repeater relays every data packet to the
Network Access Point. Finding an optimal location for the Network
Access Point radio pod is important so that a minimal amount of repeaters
are required.

Exposure to Temperature (above 122 degrees F) — In higher
temperatures, the batteries passivate (build up an internal resistance).
The wireless sensors monitor the temperature and battery voltage and
regulate passivation by using battery current to break down the internal
resistance. For higher temperature applications, a high temperature
battery is recommended. Insulation blocks can also be used in mounting
the sensor to reduce the internal temperature.

Shelf Life and Storage — Lithium batteries have shelf lives in excess of
10 years when properly stored. The Lithium battery will discharge its
electrical capacity slowly over this period (approximately 1-2% per year).
For this reason it is not practical to have Lithium products operate longer
than 10 years. Any battery not used for a period of several weeks should
be stored in a refrigerated environment (35F — 40F) for maximum shelf
life.

Battery life calculation described in these documents:

Battery life time calculation for 7034000-1.doc
Battery life time calculation for 7033000-1.doc
Battery life time calculation for 7043000-1.doc

Each document contains MS Word active form (like shown bellow), what is used
to calculate battery life time for different conditions.

7034000-1 Battery Life time calculator

Battery Capacity, Ah 1.1
Sample Count 2048
Sample Rate, Hz 1000
Extra Sampling, % 0
Polling On ]
Records per day 24
Radio link Quality (0 - 1) 1
Life Time, Hours 18921
Life Time, Days 788
Life Time, Months 25.8
Life Time, Years 2.16
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Appendix IV, Operational Distances of Radio Links

The transmission distances of the Maintenance Watchdog wireless products are
difficult to predict for the complex environments common in industrial settings.
The operational distance will be a result of many factors including:

= Line of sight

= Reflections

* Obstacles

= Walls

= Height from ground

= Interference

= Moisture content in atmosphere

A general guideline for the wireless operational distances can be found in the
following table for open ground communication. Actual distances can be less or
greater depending on the above factors.

WAP above 2m ground level Sensor above 1m ground level 330 feet (100 m)
WAP above 1m ground level Sensor above 1m ground level 250 feet (75 m)
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